VBA Programming: Part |

Online support: https://support.office.com/en-
US/article/create-or-run-a-macro-c6b99036-
905c¢-49a6-818a-dfb98b7c3c9c

VBA (Visual Basic For Applications)

* VBA is a “programming language”

— A programming language allows a person to write a computer program

— VBA is based on but not identical to Visual Basic (VB)

— Visual Basic is seldom used

— VBA programs must be associated with a ‘host’ application (usually it’s
Microsoft Office document such as MS-Word but other applications can
also be augmented by VBA programs).

— Because host applications such as a Office are popular, VBA is still used to
create actual programs.
* The host application is enhanced or supplemented by the VBA program
* “Why do | have to keep going through these same steps over and over again for

each document?”
—VBA can be used to automate tedious tasks

* “Why doesn’t this stupid word processor have this feature??!!”
—Now you can add that feature yourself using VBA
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VBA And Macros

* A macro programming language: allows a series of commands
to be recorded into a computer program.
— Running the program will execute that sequence of commands.
— Because VBA does have a macroing capability VBA is often referred to as
a ‘macroing’ language.

IHImportant Warnings!!!

* Because the VBA programs modify Word documents, close
important Word documents when you run your programs.

* Also, if a VBA program you are running will modify Word
documents at a specified location (e.g. C: \work\) make sure
that you NEVER put any of your important documents at that

location.
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Accessing The Program Writing Capability In Word

* Method 1: In the Word ribbon look under the ‘View’ ribbon

— This ribbon is visible by default
— But looking the View-ribbon doesn’t show all the options for macros
* Can’t ‘record’ macros: this doesn’t affect your working 203 assignment but it’s
something to keep in mind if you ever need the auto record capability in the

future.
* Method 2: Alternatively you can enable the ‘Developer’ ribbon

— This ribbon has more options than the View-ribbon

Method 1: View-Ribbon

e View->Macros
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Method 2: Developer-Ribbon

* Steps for making a new ribbon tab (Developer) visible

1. Select the ‘File’ tab in the ribbon
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Viewing The ‘Developer’ Ribbon (MS-Word)
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Viewing The ‘Developer’ Ribbon (MS-Word): 2

* This should add a new tab in the ribbon “Developer”

VBA for CPSC 203.docx -Jyqud

-
Layout References Mailings Review view € Developel

™ Calibri (Body) ~|11 ~| A" A" Aa~ fe Z-i=-%sc (E=3E AT | aanen A

How To Create VBA Programs

1. Method 1: Record the macro automatically: keystrokes and
mouse selections will be stored as part of the program

2. Method 2: Manually enter the program (type it in yourself
into the VBA editor)

VBA programming: Part | 5



Method 1: Recording A Macro

* Developer ribbon
— Click on “Record Macro”

@‘ H9-0|= VBA.doc [Compatibility Mode] - Microso

Home Insert Page Layout References Mailings Review View Developer

E ?a ;ﬂii\fﬂ:m ) ’E@‘} \a Aa :J &2 Design Mode \E %fciema .

i CHEE | #F properties

Wisual Macros ) "~ AddIns COM _ = . Structure g, ) .
Basic A Macro Security adddns | B B G- & Group & Expansion Packs
Code Add-Ins Controls HML
'ﬁ e e T T T T e T
— Recording details What to name the

i i macro (next slide for
Macro name: more info)

Macro2

Assign macro to

Document to store
e o the macro (select
Store macro in:

‘Al Documents (Normal.dotm) B the current Word
document)

Recording A Macro (2)

* Give the macro a self explanatory name and press ‘OK’ (recording

begins).
rRemrd Macro M‘

Macro name:

macro_to_make_font_bold

Assign macro to

Kermoara
Store macro in:

All Documents (Normal.dotm) B

All Documents (Normal.dotm, -
Making text bold.docm (document]

* Important reminder: record the macro in the current document

and not “All documents” (Important!)
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Recording A Macro (3)

* While recording you can run whatever Word features you want
to add to the recording of the macro

— In this case you would select bold font

Home Insert Page Layout References Mailings Review View Developer Tam tab

Times Mew Rom ~ 12 = A~ A7

T | 4aBbCcI AaBl

B Emphasis  Headin

]
Paste f - abe X, X*

Clipboard Font
!

— For this simple example all commands have been entered so you can stop
the recording (click “Stop recording”)

[w] Document? - Microsoft Word
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23 5 | @ Press Fifor more help.

Running A Recorded Macro

* Under the ‘View’ ribbon select ‘Macros’

File Home Insert Design Layout References Mailings Review Developer  ACROBAT Q Tell me... Sig|
= |:| ] [=] outline | ] Ruler q [E) E] one Page £ New Window [ ED’_J D
[ pratt Gridlines M [E Multiple Pages = Arrange All
Read | Print Web Zoom 100% Switch Mac
Mode |Layout] Layout | Navigation Pane «E Page Width ] split T .
Views Show Zaom Window Macros

* Select the macro (Under “Macro name”) and then click ‘Run’
= =)

Matro name:

macro_to_make_font_bold

:

macio to make font bold -

Macras in: | All active templates and dacuments [+]
Description:

Cancel
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Running A Recorded Macro (2)

* In this case nothing happened?
— This macro changes selected/highlighted text to bold
— You need to select some text before running the macro

@ Documentd - Microsoft Word = = 52
Home | Insert | Page Lay | Referen | Mailing: | Review | View | Develop | Tamtab | & @
= Times Hew R ME E = iE
_1 & Times New nm::e - FE A &
B 23 B I U~ x, x| = =~
g = & o Styles | Editing
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Clipboard = Font
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Navigation > X [izz]
Search Document P~ é
oo [ =
EREEA=

This document does not
contain headings.

To create navigation tabs,
create headings in your
document by applying
Heading Styles,

w on 4

Page:1ofl | Words:1/1 | <8 |

Running A Recorded Macro (3)

* After selecting the text and running the macro again, whatever
text was highlighted now becomes bold.

W Documentd - Microsoft Word 2 =

o
Hums Insert | Page Lay | Referen | Mailing: | Review | View | Develop||Tamtsb| & @
‘j‘&
Macros
New Group
H9-0l#hd -~

Navigation > X

Search Dacument P~

& |86 | &

M :?l

This document does not
contain headings.

To create navigation tabs,

create headings in your ~
document by applying EY
Heading Styles. o
®

»

(F)

Page:1of1 | Words:1/1 | 8 |
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Other Examples Of Useful (?) Recorded Macros

* Printing: selecting a printer and setting print options can be
tedious if your print driver application does not save your
previous selections.

— Even if previous selections are saved recording a macro may be useful if
you have multiple printing profiles e.g. | print low quality black and white
double sided documents stapled on the top left for staff and high quality
color single sided with multiple staples with glossy paper for clients.

* Entering hard to spell words (especially if they are new)

— Example: “Gotterdammerung” is hard enough to spell but this word is
supposed to have the “umlaut” for the ‘o’ (actually 6) and ‘a’ (actually a).

— JT: shifting to German keyboard in Word can be done via: <Ctrl>-
<shift>-<;> (this key combination must be entered prior to typing
each alternate character).

Method 1: Recording Macros (Comments)

* It's a good and simple way for anyone to automate a tedious
series of commands in Word.

* This approach is quite limited.

— E.g. how would you record a macro to automatically open, edit and print
all the documents in a folder?

— The main goal in introducing the recording approach is to make you
aware of this capability for your future use.

* For the assignment this approach will not work.

* Also on the exam you must manually write macros (on paper)
or trace a macro (figure out what happens when it runs).
— “Recording” is not feasible for the exam
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How To Create VBA Programs

1. Method 1: Record the macro automatically: keystrokes and
mouse selections will be stored as part of the program

2. Method 2: Manually enter the program (type it in yourself
into the VBA editor)

— This is how you are to complete your assignment and is how many VBA
programs are created.

— Consequently the remainder of the course notes will focus on Method 2

The Visual Basic Editor

* You don’t need to familiarize yourself with every detail of the
editor in order to create VBA programs.

* Just a few key features should be sufficient
* Starting the editor:

—Because VBA programs are associated with an office application open
the editor from MS-Word
—‘View->Macros->’
* Making a new macro then select: ‘Create’

* Accessing a macro you already created: ‘Edit’ (greyed out in the image
because no macros have been created yet).

Macro name:

:

VBA programming:
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Important Reminder!

* Reminder: After the previous step (clicking on “Visual Basic”)
you will need to indicate that you want to save the VBA
program in the CURRENT DOCUMENT not in all documents.

File Home Insert Design Layout References Mailings Review
= ™ *JRecord Macro - O Aa Aa = [ B Desian Mode =
M T X .
Vsl Macros ML Mapping Name of Word
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Navigation
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‘Word commands
It's a great way to ke
or quickly move you
To get started, go ta Concel

Save the VBA macro in this document
‘Document4’ NOT in “All documents’

Overview Of The Important Parts Of The VBA
Editor

Cut, copy, Find, Help lookup
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1 Microsoft Visual Bask - Normal =

i Fille Edit View Msert F

Debug Run Tools Addns ﬂmdw activeDocurMnt -
i 3l b B A9 e DB | @ 1 col2 !
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End Sub / I / j

Spb First ExamplefMacro Ingb()

Macro
12/06/20f4 by James Tam

' First_Example fMacro_Wne
' Macro record

Program
‘ editor
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i MsgBox (JCore cperaghing system: " & System.CpegatingSystem) |
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VBA programming:

Part |

10/15/2020

11



10/15/2020

VBA Editor: Don’t Mix It Up With The Word Editor
rﬁﬁ Microsoft Visual Basic - Normal | B ]

! File Edit View Inset Format Debug Run Tools Add-Ins  Window Help activeDocument -

(A g g0 e on @ ]SS | @ 1, Col2 !
% MNormal - NewMacros (Code) EI@
||Genera|) j |First_Example_Macro_lnfo j

End Sub Z‘

Sh.b First Example Macro Info()
'

' First_ Example Macro Where Macro
' Macro recorded 12/06/2014 by James Tan

il 3 E VBA for CPSC 203.docx - Word
Home Insert Design Layout References Mailings Review Developer
| .l D [E] Outline Ruler q [E) [El one Page £ New Window [ Vig
2 [= Draft Gridlines El gg Multiple Pages =) Arrange All Syr
Read ' Print Web Zoom 100%
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\BA for CPSC 203

P Microzcr Vizas! B - Noemal S

e pre—
Writing A Program In The Fp—— ==
=] [Fist_ Examgie._Macro ot jJ

VBA Editor

* Format:
' Program documentation goes here (more on this later)
sub <sub-program name> ()
Instructions in the body of program (indent by 1 tab)
End Sub

* Example:
' Author, version, features etc.
Sub first_example_macro_info()
MsgBox ("First computer program")
End Sub

* Note: large VBA programs have multiple (sub) parts but for this
class you only need to define a single ‘sub’.

VBA programming: Part | 12



Saving The Macro

* Save using Word rather than in the VBA editor

* Make sure you ‘Save as’ as a MACRO ENABLED Word
document

[ saveAs

t > ThisPC > tamj (\\nsi.cpsc.ucalgary.ca) (U:) >
Organize v New folder
& test203 Comput Name
& workHome
Gy

@@ OneDrive

[ This PC

# 3D Objects  [Word Document (*.docx)
B Desktop Word Macro-Enabled Document (*.docm)

Word 97-2003 Document (*.doc)
%] Documents |Word Template (*.dotx)

Word Macro-Enabled Template (*.dotm)

& Downloads |\word 972003 Template (*.dot)

Creating A VBA Program By Typing It

¢ Under the Word Ribbon

— View->Macros->View Macros

* (Then a popup “Macros” appears)
— “Macros in” <select the option that stores the macro ‘in’ the option
whose name matches the name of the Word document (last option)

— “Macro name”: usually you should enter a good self descriptive name, if
you can’t think of anything else for your test program then call it ‘test’.
— Then select ‘create’

VBA programming:
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Entering The Program Into the VBA Editor

* (Selecting ‘create’ in the previous step then causes the VBA
editor to appear)

E Microsoft Visual Basic for Applications - Documentl

Enter your program
here (indent each level

File Edit View Insert Format Debug Run  Tools Add-Ins  Window Help

WE- - a9 bouoE N EE 2@t by at least one tab),
P ot P ct x 1
r;le x| 8 Documentl - NewMacros (Code) until you see the
- B (cenera examples in the last
& Normal - .
& Project (Document1 | Sup test () section of notes there
(7 Microsoft Word Obje ' .
.53 Modues - ' test Macro will only be one level of
a4 I, ] » ' . .
indenting.
Properties - NewMacros x|
NewMacros Module - End Sub

Alphabetic | categorized

(Name) MewMacros

* Much of the rest of the VBA lectures will describe the types of
instructions that you can type between the ‘sub’ and ‘end
sub’

Copy-Paste The Program (VBA Editor->Word)

H ©- s

cument containing a progra

H -0 - Word document containing a program.docm
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Project - P x| [(Generan | [ N Subtest()
] : N !
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e :
=5 Mc =B -
e :
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Fmpertlsi' fim Quick Info N End Sub
N ,
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Transferring Your Work

* If you work on your own computer you need to test your
program periodically.

* If you work only on campus computers then you need to save
on a flash drive or via the cloud.

* Important summary:
— Save the VBA macro in the current Word document:

Macros in:  Documentd (document) :]

Descriptiond All active templates and documents
- Normal.dotm (global template)
Word commands

— And you saved that document as a Word Macro-Enabled document
(*.docm) then you simply have to transfer that Word document.

Word Document (*.docx)
Word Macro-Enabled Document (*.docm)
Word 97-2003 Document (*.doc)

— Copy-paste the VBA program into the body of regular Word document
(at least the Word document containing your program) just to be safe.

First VBA Example

* Learning Objectives:
— Creating/running a VBA program
— Creating a popup message using a “MsgBox”
* Reminder steps (since this is your first example)
— Start up the application (MS-Word)
— Invoke the VBA editor: View->Macros->Create
— If successful you should see something similar to the image

2 Microsoft Visual Basic for Applications - Normal - [NewMacros (Code)]

i File Edit View Inset Format Debug Run Tools AddIns Window Help

b @ EEY S @ nns,cn
neran <] [simplevansbietxampie

Enter your program
instructions here
(program editor)
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First VBA Example (2)

* Type in or cut-and-paste the following example into the VBA
editor (see the image previous slide for how the editor
appears)

— This is NOT the same as pasting it directly into MS-Word.

— Word document containing the macro (empty document see the macro
editor for the important details): 1firstExampleMacro.docm

Microsoft Word X

This is your first computer program

Opening Word Documents Contain Macros

* If you don’t change the default setting in Word you should get
a warning when you open the Word document (containing
macros).

* You can “enable the content” of your own programs or the
examples that | wrote.

=] G =- = TfirstExampleMacro.doc... =

= Calibri (Body) -1 - = Ay el
PEE BETU e Paragraph Styles Editing ) .
% A-F-A-ra- KA - - JT’s caution
FlBDoard font = ~ |+ You should NOT casually select
I SECURITY WARNING Macros have been disabled. Enable Conteny x . .
this option for all MS-Word
documents

* It’s recommended that you ONLY
enable macros you have created
(or the lecture examples)
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New: Opening Word Documents Contain Macros

* Recently (noticed as of Oct 2020) there was a change in how
Word handles Macro security.

* The popup shown in the previous slide may not appear yet and
macros will not run even if you change the security settings in
Word to the least restrictive security settings! :(

— The popup error message is not helpful. \_(*V)_/~

Microsoft Visual Basic for Applications x

The macros in this project are disabled. Please refer to the
| online help or documentation of the host application to
determine how to enable macraos.

New: Opening Word Documents Contain Macros (2)

* What's the issue?
— Microsoft’s Word developers in it’s collective wisdom decided to move
the option to enable macros from a prominent place in the Home tab.

L Calibri (Body) -1 = Mo
D B I U -abex X' #
S Y A-¥-A-m- AR
Clipboard Font 5
1 SECURITYWARNING Macros have been disabled. | Enable Content

Paragraph Styles  Editing

Info

IfirstExampleMacro
i home s 4093

Fon work hame s 409's nates » programs = part]

Security Warning

VBA programming: Part |
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Option Explicit

* It’s a good idea to include this in all your programs.
* It should be located before the ‘sub’ keyword.

Option Explicit

Sub first example macro()

' first_example macro_info Macro

MsgBox ("This is your first computer program"™)
End Sub

* Explanations about what it does will come in subsequent
lectures (in conjunction with more advanced material).

* For now “just add it in”.

Reminder: Running Macros

e Click View->Macros

File Home Insert Design Layout References Mailings Review Developer  ACROBAT Q Tell me.., Sig|
| = D | [El outline | [+ Ruler Q [E) E] one Page £2 New Window (T3 ED'_] D
= = Draft Gridlines 0 [ Multiple Pages | = Arrange All
Read | Print Web Zoom 100% Switch Mac
Mode |Layout] Layout | Navigation Pane B Page Width =] split T
Views Show Zoom Window Macros

* The single macro should be highlighted, then click ‘run’

Macros

Macro name:
first_example_macro

Step Into
Edit

VBA programming:
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Running VBA Programs You Have Entered (2)

* Or you can run the program right after you have entered it (in
the editor).

£ Microsoft Visual Basic for Applications - TfirstExampleMacro

Eile Edit View |Insert Format Debug Run Tools Add-Ins  Window Help

M E- = @l s&;%i’&;ﬁrj @ n3 coizs
X
4 tfirstExampleMacro - NewMacros (Code) [ -E ]
= ‘:General] \/‘ |f|rsl_exampla_ma:m vl
5 irst_example macro() f
' first example macro_info Macrd|

MsgBox ("Congratulations! This is your first computer program’)

End Sub
v

< >

1. Ensure correct 2. Press the
program “sub” is ‘play/run’ button
to be executed or “F5”

(click there)

Program Structure And The ‘Sub’ Keyword

* Sub stands for ‘subroutine’ or a portion of a VBA nrogram
Format: Header, start of subroutine:

. 1. Has word ‘Sub’
Sub <subroutine name>()<—— |5 Name of subroutine

<Instructions in the subroutiney 3. Set of brackets
End Sub

Note: all lines in between are
indented (1 tab, 2+ tabs if sub-

* Example: indenting is used — later sets of notes)

Sub First_Example_Macro_In

End of subroutine:
e Has‘End Sub’

End Sub
* Unless otherwise told all VBA program statements must be
inside the subroutine (“Option Explicit” excluded)

VBA programming:
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The ‘Sub’ Keyword: 2

* Real world VBA programs will be broken down into multiple
‘subs’ (subroutines or program parts)
* Again: Because this is only brief introduction into writing VBA

programs you will only have to define one subroutine for your
assignment.

Naming The Subroutine

* This is what follows the ‘sub’ keyword.

* Example
Sub formattingResume
End Sub

* Naming standards:

— The name chosen should summarize what the program is supposed to
do.

— The choice of the name will play a role in determining your assignment
grade.

— If you can’t come up with a good name for the assignment then at least
make it a practical one for the marker e.g. “a3”

VBA programming: Part | 20



Choosing A Name: VBA Technical Requirements

Must start with an alphabetic letter, after than any
combination of letters and numbers may be used

— OK: “assigmentl”, “a2939” Not OK: “lassignment”,
“*assignment”

Maximum length of 80 characters

It cannot contain spaces, punctuation or special characters
suchas#or!

— ‘resume headings’ (Not Allowed: space character)

— ‘macros!’ (Not Allowed: special character)

Can contain underscores (separate long names)

VBA Programming: How To Study

At the very least: try typing the programs into the VBA editor
or cutting and pasting them yourself (watch for altered
characters such as quotes)

= Sub first_example
¢ MsgBoxX(“Phis

SR e e

For the more complex programs (end of this section as well as

the next section) try re-creating the programs on your own:

— Think about what tasks are accomplished by my solution program

— Without looking at my solution try entering into the program into the
VBA editor to accomplish these same tasks

With programming you learn by “doing yourself” rather than

by watching someone else ‘do’

VBA programming: Part |

10/15/2020

21



10/15/2020

Microsoft Word x

IVI e Ssa ge B OX Congratulations! This is your first computer program

(Details of the previous example)
* Creates a popup window to output information from your
program
* Useful for testing
—Is my program working?
—Which part is running?
* Also useful for displaying status messages about the current
state of the program

Creating A Message Box

* Format:
MsgBox ("<Message to appear>")

* Example:
MsgBox ("This your first computer program™)

Notes on ‘Format’:

e|talicized: you have a choice for this part

eNon-italicized: mandatory (enter it as-is)

eDon’t type in the angled brackets (used to help you visually group)
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VBA Visual Aids: Function Arguments

* As you type in the name of VB functions you will see visual
hints about the arguments/inputs for the function.

Sub FunctionWithErrors()

MsgBox |
En MsgBox{Prompt, [Buttons As VbMsgBoxStyle = vbOKONly], [Title], [HelpFile], [Context]) As YbMsgBoxResult |
1 T

{ Y J
Function arguments
(Bold): mandatory
arguments
— JT: You won’t need to worry about all functional arguments for this class.

— Enter the function name and then a space

VBA Visual Aids: Error Information

* The requirements for forming VBA programming instructions

are referred to as the ‘syntax’ (grammar/rules) of the language.

* Syntax violations are visually highlighted in VBA:

Dim Doghge As Integer | MicrosoftVisual Basic for Applications [x£3s|
Name = InputBox ("What
Zge = InputBox("What i
Doghge = Age * 7 Compile error:
MsgBox (Name & " your '

End Sub Syntax error
Sub FunctionWithErrors ()

iscsox 0 J Lok |

MagBox ()] 0K Help
End Sub

Required argument missing

Part of program that contains

Sub FunctionWithErrors (g ,———  ©€frors (vellow highlight)
MsgBox ("ok™) Specific
MagBox {)e_ . .
statement/instruction
End Sub .
causing the error (red font)
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Program Documentation

* Your VBA assignment submission must include identification
about you and information the features of your program
—Full name
—Student identification number
—Tutorial number (if applicable)

—List the program features (from the assignment description) and clearly
indicate if the feature was completed or not completed.

—Program version

* DON'T just enter this information into your program

instructions

Sub FunctionWichErrors()
MsgBox ("Confirm receipt of message™) Instructions for the
aEiss Tam computer
Tutorial 1

End Sub \/Computer): problem, | don’t know how

to run the “James Tam” instruction

Program Documentation (2)

* You must ‘mark’ this information so it doesn’t cause an error

— The marking will indicate to the VBA translation mechanism that the line
is for the reader of the program and not to be translated and executed

— The marking is done with the single quote
* Format:
'<Documentation>
* Example:
'Author: James Tam
* No error: Everything after the quote until the end of the line
will not be executed

¢ That means documentation doesn’t have to be a valid and
executable instruction
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Program Documentation (3)

* Contact information should be located before your program
* Before the ‘sub’ keyword and before the “Option Explicit”

5 Microsoft Visual Basic for Applications - 2types - [NewMacros (Code]]

%Eile Edit View Inset Format Debug PRun  Teols  Add-Ins  Window
ME- gl P dRIBEEFY 2@IL
Project-& |:General]

= = ' Author:
| Version:

ing o Documentation:
v ables: real/double, integers marked in red
' Using the message box to display information

Cption Explicit

Subk secondExample ()

| Dim realNumber &s Double
¢ Dim wholeNumber As Long
C

Program Documentation (4)

* Program features (this will be worth a fair number of marks)

* Example assignment description

5. Pnnt the document (you won't actually be able to print anything in the 203 labs because there are no printers
connected to the computers) but your program should be able to invoke the print command using VBA. (+8.2
GPA)

6. Close the document and automatically save changes (no choice given to the user). (+8.2 GPA)

7. Instead of applying Features 1 - 6 on just a single document, the macro will instead 1t will prompt the user for a
location (e.g., "C: \temp") via a InputBox and apply Features 1 - § to every Word document in that location.
When vou write the program you can assume that the folder only contams Word documents. You must employ
nesting in order to get credit for this feature. an outer loop successively opens each document in the specified
location and inside the loop body Features 1 - 6 will be applied. (+1.© GPA)

* Program documentation
— "Author: James Tam  ID: 123456
— "Version: Nov 2, 2015

— 'Tutorial: 99

— 'PROGRAM FEATURES

— "#5: Printing: completed These are easy
— ' #6: Close and save: not completed marks to earn!
— etc
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Program Documentation (5)

* Versioning

— It’'s a commonly used industry practice:

=

Internet
Explorer1

Claw

— For assignments you can either use version numbers or dates
(recommended)

Program Versioning And Back Ups

* As significant program features have been completed (tested
and the errors removed/debugged) a new version should be
saved in a separate file. A3.0ct2

' Version: Oct 2, 2012
' Program features:
' (2) Count, display typos

A3.docm

' Version: Oct 2, 2012
' Program features:
' (2) Count, display typos

' Version: Sept 20, 2012
' Program features:

' (5) Print

' (6) Save & close

Make new

' Version: Sept 30, 2012
' Program features:

' (5) Print

' (6) Save & close

A3.Sept30

' Version: Sept 20, 2012
' Program features:

' (5) Print

' (6) Save & close

Don’t touch the backups (date in the file name)
and only work on A3.docm
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Additional Backup Tip: Copy-Paste

* Periodically copy-paste the VBA program into a regular Word
document

& Microsoft Visual Basic for Applications - 2variablesMixedOuty

M File Edit View Inset Format Debug Run To

&-H #l9 yom @ b
Project J | (General)
B - ption Explicic

Sub sccondExample ()
Dim num As Long
num = 7
HsgBox {lpum—" & num)

End Sub

Option Explicit

\:un secondExample
- Dim num As Long

num=7
MsgBox ("num="& num)
End sub

Variables
* Used to temporarily store information at CPSC mail
location in memory
* Variables must be declared (created) before Il
they can be used. B

* Format for declaration:
Dim <Variable name> as <Type of variable>

* Example declaration:
Dim BirthYear as Long
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Common Types Of Variables

Type of information | VBA Name Example variable Default Value
stored declaration

Whole numbers Long Dim LuckyNumber
as Long

Real numbers Double Dim MyWeight As 0
Double

Chararacters! String? Dim Name As Empty string
String

Date? Date Dim BirthDate As  00:00:00
Date

1) Any visible character you can type and more e.g., ‘Enter’ key
2) Each string can contain up to a maximum of 2 billion characters
3) Format: Day/month/year

Variable Naming Conventions

* Language requirements (syntax):
— Rules built into the Visual Basic (recall VBA is essentially Visual Basic
tied to an MS-Office Application) language.
— Somewhat analogous to the grammar of a ‘human’ language.
— If the rules are violated then the typical outcome is the program
cannot execute.
* Style requirements:
— Approaches for producing a well written program.

— (The real life analogy is that something written in a human language
may follow the grammar but still be poorly written).

— If style requirements are not followed then the program can execute
but there may be other problems (e.g., it is difficult to understand

because it’s overly long and complex - more on this during the term).
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Naming Variables: VBA Language Requirements

* Names must begin with an alphabetic character
— OK: namel Not OK: 1name
* Names cannot contain a space
— OK: firstName NotOK: first name
* Names cannot use special characters anywhere in the name
— Punctuation: ! ?
— Mathematical operators: + - * / ~
— Comparison operators: < <= > >= <> =

Naming Variables: Style Conventions

1. Style requirement (all Examples
languages): The name should be j;é (yes)
meaningful. .y (noy

2. Style requirement (from the
Microsoft Developer Network?):

a) Choose easily readable HorizontalAlignment (yes)
identifier names AlignmentHorizontal (no)

b) Favor readability over CanscrollHorizontally (yes)
. ScrollableX (no)
brevity.

1 http://msdn.microsoft.com/en-us/library/ms229045.aspx

VBA programming: Part |

10/15/2020

29



3. Style requirement: Variable
names should generally be all
lower case except perhaps for
the first letter (see next point for
the exception).

4. Style requirement: For names
composed of multiple words
separate each word by
capitalizing the first letter of
each word (save for the first
word) or by using an underscore.
(Either approach is acceptable
but don’t mix and match.)

5. Avoid using keywords as names
(next slide)

Naming Variables: Style Conventions (2)

Examples

#3:

age, height, weight (yes)
HEIGHT (no)
#4

firstName, last_name
(yes to either approach)

And

Date
Each
Exit

Get
Integer
Long

Not
Optional
Property
Set

Stop
True
Widening

Boolean
Decimal
Else
False
Global
Interface
Loop
Nothing
or
Protected
Shadows
String
Try

With

Call
Default
End
Finally
Handles
Is

Me

of

Out
Public
Short
Sub
Using

Some Common Visual Basic Keywords?

Case Catch Continue
Dim Do Double
Erase Error Event
For Friend Function
If In Inherits
Let Lib Like

Mod Module Next

On Operator Option
Overrides Partial Private
Resume Return Select
Single Static Step
Then Throw To
Variant When While

1 The full list can be found on the MSDN http://msdn.microsoft.com/en-us/library/dd409611.aspx
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Variable Naming Conventions: Bottom Line

* Both the language and style requirements should be followed
when declaring your variables.

CPSC mail

Examples Of Assigning Values To
Variables = 1l
[

Note: some types of variables requires some
mechanism to specify the type of information to be
stored:

e Strings: the start and end of the string must be marked with double
quotes "

* Date: the start and end of the string must be marked with the number
sign #

Dim LuckyNumber As Long
LuckyNumber = 888

Dim BirthDay As Date
BirthDay = #11/01/1977#

Dim MyName As String
MyName = "James"
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Basic Mathematical Operators

Symbol used in VBA

Addition + 2+2
Subtraction - 3-2
Multiplication * 10 * 10
Division / 81/9
Exponent A 273

MsgBox And Variables

* Typing the name of a variable in a message box (no quotes) will
display the current contents of that variable.

* Example (from a program coming up)
Dim realNumber As Double
realNumber = 1 / 3
MsgBox (realNumber)

0.333... appears

MsgBox ("realNumber")

s\\\\\\\\\\“* realNumber appears
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Second VBA Example (2)

Learning objective: Display the contents of variables
Word document containing the macro: 2types.docm

Sub secondExample() Microsoft Word (i)
Dim realNumber As Double J———

Dim wholeNumber As Long =
Microsoft Word

0

realNumber = 1 / 3

MsgBox (realNumber)
wholeNumber = 5 / 10
MsgBox (wholeNumber)

Microsoft Word @

wholeNumber = 6 / 10 !
MsgBox (wholeNumber)
End Sub

JT’s note: Anything over 0.5 is rounded up

Common Mistake #1

* Avariable is just that — it can change as a program runs.

* Approach #1: variable not used (lacks flexibility)
MsgBox ("My age is...")
MsgBox ("...37")

* Approach #2: variable employed (age can be changed with any
mathematical expression)
Dim age As Long
age = 37
MsgBox ("My age is...")
MsgBox (age)
age = 38
MsgBox ("My age is...")
MsgBox (age)
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MsgBox: Displaying Mixes Of Strings And Variables

* Format:
MsgBox ("<Messagel>" & <variable name>)

* Learning objective: Mixed output in a MsgBox (variables and
constant text strings)

* Name of the online example: 3variablesMixedOutput.docm
Dim num as Long
num = 7
MsgBox ("num=" & num)

"num=" : A literal string
num: : contents of a variable (slot in memory)

Why Mix The Display Of Strings & Variables

* Labeling variables as they appear makes your program easier
to understand

Student 1:
Student 2:
Student 3:

Vs. Student 4:

Student 5:
Student 6:
Student 7:
Student 8:
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Student Exercise #1: Mixed Output

* What is the output of the following MsgBox:

* Solution: Exercisel.docms

\ W AR

\ 2 :
Variables: Metaphor To Use [M/\|N:{e)# "

www.colourbox.con,

* Think of VBA variables like a “mail slot in memory”

* Unlike an actual mail slot computer variables can only hold
one piece of information

— Adding new information results in the old information being replaced by
the new information

Dim num as Long

Representing
num twice
~— doesn’t mean
there exists
two locations
by this name

num = 1

num = 17
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Common Mistake #2

* Assigning values from one variable does not ‘link’ them

Student Exercise #2

* Also each computer variable is separate location in memory.

* Each location can hold information independently of other
locations.

* Note: This works differently than mathematical variables!

* What is the result?

¢ Solution: Exercise2.docms
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Getting User Input

* Asimple approach is to use an Input Box

* Format:
<Variable name> = InputBox(<"Prompt"s>, <"Title bar">)

* Example:
Name = InputBox("What is your name", "Getting Personal")

* Note: only the string for the prompt (first) is mandatory.
If the title bar information is omitted then the default is the

application name (” Oft Word”) GettmgPersona\l—/ @
What is your name
=

Example: InputBox

* Learning objective: getting information from the user.
* Word document containing the macro:

4inpUtBOX . docm Getting persenal: name ===
What is your name fatna
Getting even more personal: age @
What is your age

Sub InputExample()
Dim age As Long james ten o |

Dim name As String 5

Dim dogAge As Long
name = InputBox("What is your name", "Getting personal: name"
age = InputBox("What is your age", "Getting even more personal: age")

dogAge = age * 7 Microsoft Word =
MsgBox (Name & " your age in dog years is " & dogAge)
End Sub james tam your age in dog years is 259

Note: there are two input boxes, one that prompts for the name and the other
for the age. Each is given a self-descriptive name to distinguish them (an
examnle of sood nrosramming stvle — mare on this shortlv)
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Student Exercise #3: Getting Input, Display Output
Based On The Input

* Write a program that will ask the user for their age and name.

* The program will then display the name and age of the user in
the following format:
— Format of what program displays:
*<Name> : <Age> is a good age
— Example output: user enters ‘james’ and 1
*James: 1 is a good age

* (You can use Example 4 as a starting point for your program).
* Solution: Exercise3.docms

The Line Continuation Character

* Learning objective: how to split a long VBA instruction
between multiple lines.

* Misnomer: The “line continuation character” is actually two
characters.

— Space (i.e. press the space bar)
— This is immediately followed by the under score
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Line Continuation Character Example

* Example VBA document containing the program:
51lineContinuationCharacter

Dim name As String
Dim address As String
Dim phone As String
Dim age As Long
name = InputBox("What is your name")
address = InputBox("Address: ")
phone = InputBox("Phone (format: (XXX)xxx-xxxx): ")
age = InputBox("What is your age") B
MsgBox (name & " lives at " & addressf_\)
& " " & phone & " " & age) o

The last line is equivalent to:
MsgBox (name & " lives at " & address & " " & phone & " "

& age)

After This Section You Should Now Know

* How to copy and run the pre-created lecture examples
How the VB editor identifies programming errors

* How to create and execute simple VBA macros
— You should know that macros can be automatically recorded but specifics

will be covered in tutorial
Manually entering programs into the VB editor yourself

* How to create/use a Message Box “MsgBox”

* How to create and use variables
* Naming conventions for variables

* How to use basic mathematical operators in VB expressions

VBA programming: Part |

10/15/2020

39



10/15/2020

After This Section You Should Now Know (2)

* What are commonly used variable ‘types’ in VB
* How to get user input with an Input Box “InputBox”

* How to create program documentation (as well contact
information that should be included in documentation)

Images

* “Unless otherwise indicated, all images were produced by
James Tam
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